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The Elm Tree

E

arly in June we (my wife and I) headed overseas to enjoy some northern
hemisphere summer! We started our visit to England in Birmingham
where in our first three days there was the equivalent of three months of
rain!

			

We took the opportunity of travelling with QANTAS on the direct f light:
Melbourne to Perth and then non-stop to Heathrow. Remembering that
many of our ancestors took up to five months for the journey; from the time
the aircraft wheels left the ground at Heathrow and I was unlocking the
door at home twenty-two hours had elapsed. How would our Ancestors have
ever conceived that possibility?

There were two reasons to visit Birmingham one being, of course, the ongoing pursuit of ancestors
and the second to attend the inaugural Genealogy Show. This event was held over two days, the
7th and 8th of June. I will discuss the Birmingham Genealogy Show further in the future.
There were four presentation rooms with six sessions in each room on each day. This is a total of
forty-eight presentations! Whilst such a number of subjects presents a wide range options, it is
impossible to attend every session of interest.
Two of the sessions on the subject of DNA presented by Blaine Bettinger were very well attended.
Blaine is a good presenter and extremely knowledgeable on the subject. I took the opportunity of
meeting with him following one of the sessions.
Unlock the Past has organised for Blaine to be the principal speaker at the
forthcoming: DNA Down Under conferences. These events are being held
in: Brisbane; Perth; Adelaide; Melbourne; Canberra and Sydney during
August. Having heard Blaine’s presentations, this event should be very
worthwhile for those interested in DNA. Full details of dates and venues
can be found on the website: https://www.dnadownunder.com
VICGUM will be exhibiting at the Melbourne event (23 August) and is a sponsor for all events.
(See pages 28 and 29).

ANNUAL GENERAL MEETING
I will also like to remind all members that our Annual General Meeting (AGM) will be held on the
25th of August. Full details can be found page 16 in the Newsletter.
I encourage all members to consider, if practical to volunteer to join the Committee. For those of
our many members interstate please consider how you may be able to assist with the management
of our group. There are many tasks which can be carried out via email and internet links.
And as usual, to finish with a laugh:
In filling out an application, where it says, “In case of emergency, notify...I answered “a doctor”
TACT is the ability to describe others as they see themselves.

Doug Elms, President

president@vicgum.asn.au			
					
					GUM
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Who’s who in your Family Zoo? or
The List of Individuals Report
When you add or remove a person in Family Tree
Maker, the application keeps track of this and all
the people in your file by way of an Index. You
normally see this Index in the left-hand editing
panel when in the People>Tree View. There are
many, many things that you can do in the Index
including Filters, Bookmarks and History. I
wrote a full article on using the Index, (see GUM
Newsletter, December 2016). This article is still
current as the Index has not changed. But this
month I am going to have a look at the Index from
another viewpoint, namely the Publish>Person
Reports>List of Individuals Report.

The List of Individuals report offers five different report options:
1.

Index of Individuals — Lists all of the people in your tree

2.

Index of Individuals with IDs — Includes Person and relationship IDs

3.

Anniversary List — Shows the marriage date and anniversary date of each married couple

4.

Birthday List — Shows the birth date and age of each person

5.

Contact List — Shows the address, email and phone number for each person

The report was added to Family Tree Maker in Version 2012. Prior to that, if you wanted an Index
of Individuals report, you had to construct it with the Custom Report to include all individuals and
in Items to include, Names (last name first) and other facts like date of birth, date of death, etc. You
can of course still run an Index report this way but the supplied List of Individuals Report is much
easier to run. So let’s look at the five options.

1.

Index of Individuals

This is the basic report and shows Name (last name first) , Birth Date, Marriage Date, Death Date
and Spouse Name.
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Hint: Viewing this report in Landscape mode on screen by using the Page Setup menu button in

the right hand editing panel makes the report easier to read as it largely eliminates text wrap. Also
setting margins to zero can assist.

Notice that the report has the same bug in it as the Kinship Report in that if you have a couple
who you have marked as [say] partners, and left the marriage date in the Tree View blank (as you
should and also note the relationship correctly in the People>Person view>Relationships), the
Index report will still list the partner as a spouse. The Kinship Report does the same thing. Can be
embarrassing.

Individuals to Include
As with all the options, you have the ability to show
the Immediate family of the focus individual, the
Extended family, All individuals, and of course Selected
individuals which brings into play the powerful Family
Tree Maker Filter. These four options are of course
standard across the application. Note also the report
length. With my 8,000 or so person file, the Index of
Individuals report for all individuals runs to 253 pages!
Not something that I would want to ever print in its
entirety. These four Individuals to Include options
apply to the five “Index” reports. For a more detailed
discussion on using the Filter in Family Tree Maker see
GUM Newsletters November and December 2017 and
also in April 2014.

Some Interesting Options
Now where this report becomes more interesting and useful is with some options namely:
 Include only living people
 Sort By: Month/day
		
Year/month/day (oldest first)
		
Year/month/day (youngest first)
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Include only living people — but who is living?
Now this is where a little discipline on how you indicate when and whether people are recorded
as deceased comes in. Consider a person born in 1919. If the person is deceased but you have not
noted this in their date of death (DoD) field, Family Tree Maker regards them as living and will
show them as being 100. In fact, anyone up to the calculated age of 113 is regarded as living…..
unless there is an entry in the DoD field for that person. So if you have been lax and left the DoD
unmarked, then your list of living people could be in error.

Hint: What I do if I know a person is deceased but I don’t know the DoD is to type in a “?” (no

quotes) into their DoD field. Family Tree Maker substitutes “Unknown” (no quotes) in the DoD
field. It also shows Unknown in the Lifespan in the Index and elsewhere. This then ensures
that only real living people make it to the “only show living people” list. Of course, you can add
anything to the DoD field. Even a full stop. But I like the “?” option as I only have to type in one
character to get seven consistent characters. Let me repeat that, “seven consistent characters”. And
of course it is very simple to run a Custom Report to show all the people with “Unknown” in their
DoD field if I want to focus on finding actual DoD dates for them. As I have said often, “consistent”
is my favourite word when talking about Family Tree Maker.

Sort By: Month/day
Changes the sort from alpha on the surname to month of their Date of Birth. So a [say] February
date of birth comes before [say] a July date of birth. The day secondary sort kicks in so 12 August is
listed before 13 August.

Sort by Year/month/day (oldest first) Year/month/day (youngest first)
Further refines the sorting to include a year.

2.

Index of Individuals with IDs

This report gives Person ID, Name, (last name first), Lifespan, Relationship ID and Spouse name
(same bug as in the Index of Individuals). I never use IDs in my file, (I have added them for this
screen shot), but if you want to then go to Tools>Options>References (Win) or Tools>References
(Mac) to display them.

Options: References/Tools References
Tools>Options>References (Win) or Tools>References (Mac), allows you to set up automatic
reference numbering of the Person ID and Relationship ID facts for each record in your tree.
The Person ID and Relationship ID facts provide a way for you to record a reference number for a person
or relationship. You can enter values in these fields manually or enable Family Tree Maker to assign
them automatically.
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When you enable the automatic reference numbers for an ID fact, a reference number is added to each
record to which you have not assigned a reference number manually. You can enable automatic Person
ID and Relationship ID numbering separately.

Manually entered reference numbers
A manually entered reference number can include any alphanumeric characters and does not need to be
unique in the tree. You do not need to enter a reference number for each record or relationship; however,
reference numbers can be helpful when searching for a record or identifying a person. You can include
as many manually entered reference numbers as you want and can replace an automatically generated
reference number with a manually entered reference number.

Automatically entered reference numbers
Family Tree Maker does not automatically assign reference numbers unless you have specified for it to do
so in the References tab of the Options dialog box. Numbering begins with the first record in the database
and incrementally assigns reference numbers according to the options you specify. There can be only one
automatically entered reference number per person or relationship. If you delete all manually entered
references, and automatic reference numbering is enabled, Family Tree Maker automatically assigns a
reference number to the person or relationship.

The only real option you have is to show only living individuals and my comments above
concerning defining the living applies.

3.

Anniversary List

This report gives Name (last name first), Marriage Spouse Name (last name first), and the
Anniversary (in years). Interestingly this report does not have the marriage/met bug noted above,
but only shows correctly entered marriages. As noted above, you should NOT record a marriage
date in the Tree View for a couple who have some other form of non-marriage arrangement like
partners, friends, etc. Again, with this report you have the same 3-sort and show living people
options as in the Index of Individuals. (In this screen shot only show living people is unchecked).

4.

Birthday List
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This report is a favourite at family reunions as it shows Name, Date of Birth and Age at next
birthday. If for family reunions you sort it oldest first, you get a great discussion list. Also, it is a
great report to high light people in your file where you have NOT recorded a DoD (see above) as it
will show people with Bradman like averages for ages. Is Aunty Mary really 111? So you can find
and fix them very quickly. Of course if she is really 111, then talk with your insurance company and
maybe send an article into your favourite woman’s magazine, or ring a TV program.
Please note in this screen shot above, I did not want to use living people for obvious reasons.
My only beef with this report when sorted oldest first is that you gradually “bubble” up to
the top of the list and finally topple off it. But of course you never get to finish your family
history as you never get to add in your own death date. Macabre thought.

5.

Contact List

If you have recorded these data, the Contact List will show you the Name (last name first), Address,
Email, and Phone number. Really to be of much use you need to add a lot of data. If I add addresses,
I tend to add (if known of course) the last known address. You have no sorting options, only the
ability to show living people only.

Other Options
At the top of the right hand editing panel you
have the usual report editing options being,
Font, Header/Footer (where you can add page
numbers and dates and time of printing), Page
setup (including margins), Save report settings,
Use report settings and Save report. These are similar in the Mac and as I have mentioned on a
number of occasions, you really need to learn these options as they apply to all report and chart
options in the Publish workspace. Mousing over each one shows its purpose.

Report Output
Other than printing, this is again where the Family Tree
Maker Share command comes into play. If you have been
following the examples shown throughout this article, you
would have realized by now that all the reports are columnar,
i.e. they are in columns. Now apart from the usual stuff
like RTF and PDF output to simply show the reports, when
you see a columnar report the CSV light comes on. CSV is
comma separated values and is one of the oldest file formats
around, long before Windows or Mac.

CSV is a simple file format used to store tabular data, such as a spreadsheet or database. Files in the
CSV format can be imported to and exported from programs that store data in tables, such as Microsoft
Excel or OpenOffice Calc. CSV stands for “comma-separated values”

Now if you Share (export) a columnar file to CSV in Family Tree Maker it will usually open in a
spreadsheet such as Excel. Now spreadsheets are a great application to sort and arrange data so an
Index in [say] Excel can be readily manipulated. So consider using CSV when playing around with
these Index like reports.
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A catch with dates before 1/1/1900 in Excel
Excel cannot handle doing calculations on these dates, they are displayed as text.
So you cannot for example find the age of a person in Excel who was born on [say] 30 June 1760 and
dies [say] 16 March 1830. Many years ago there was a brilliant little plugin called J-walk for Excel
and we ran the details in the GUM newsletter then… I think in 2004? But I am not sure if it is still
available and or if it applies to later versions of Excel? There are numerous links and articles on
Google e.g.
https://docs.microsoft.com/en-us/office/troubleshoot/excel/calculate-age-before-1-1-1900

Family Tree Maker Date Calculator
Incidentally, the Date Calculator in Family Tree Maker
can do these calculations perfectly including showing the
day of the week. This screen shot is for John F Kennedy.

General
As well as the options noted above you can also add
the usual Family Tree Maker background images and
embellishments, but probably they are not particularly
relevant for this type of report?

Surname Report
Family Tree Maker also has a related
Surname Report that lets you list and
group all the various names in your
Index the most useful option being sort
by surname count. I wrote about using
this report in the context of using it to
assist in sorting various family files in
Family Tree Maker, (See Sorting out
your files in Family Tree Maker, March
2013).

References
Not too good and nothing that I could find on the online help.
Companion Guide Windows (page 183) has three lines and a diagram and same for the Mac
(page 177).

Summary
You can have a lot of fun with these Index reports as well as analysing your data.

John Donaldson										GUM
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Footnote
Family Tree Maker Facebook site
Occasionally I have mentioned this site at:
https://www.facebook.com/groups/FamilyTreeMakerUsers/
There is a Mac one at: https://www.facebook.com/groups/FTM.Mac/
And a Family Book Creator one at: https://www.facebook.com/groups/FamilyBookCreator/
But getting back to the Family Tree Maker Windows Facebook group.

It has about 20,000+ members and has grown rapidly over the last three or so years since Software
MacKiev purchased Family Tree Maker. I wince at some of the questions on the site, but as Software
MacKiev tends to make a lot of its announcements about Family Tree Maker on the site, I follow it.
Recently the site moderator has released some interesting little tables.
Have a look at the Top City for members and then the top 1, 2, 3, cities and then the top 10 cities
includes 5 cities in Australia for the last year. Hmmm, I wonder if GUM has anything to do with
the rankings?

John Donaldson										GUM
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DNA Matrix: Snatching A Century-Old
Secret From The Grave.
0r what grandma got up to

When my cousins and I tested our DNA, we were not prepared for the surprise revealed by Charting
Companion’s DNA Matrix chart. Note the red centiMorgans (DNA Units) at the intersection below
the boxes.

The red indicates that the amount of DNA shared is too low for “first cousins”. Also, the yellowhighlighted DNA shared by the family on the left (blue), is consistently in a very low probability
range. (Click for a detailed explanation of the DNA Matrix).
There is something wrong with this chart: the genealogical relationships (family tree) are
inconsistent with the laboratory results. This tree, by the way, is based on official government birth
certificates.

What is the explanation of this discrepancy?
After further investigation centring around some puzzling remarks made a long time ago by
relatives now gone, we came to the conclusion that the (blue) family on the left could be from a
different father. In 1909, my feisty 19-year old Scottish grandmother Connie had just gotten off the
boat, alone and unsupervised on a new continent. What could go wrong? Well, she met a mystery
man and had her first daughter Ruby. Later, she met and married my grandfather Alfred, who
impersonated Ruby’s birth father.
The real tree looks like this:
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We share one grand-parent with the family on the left, which makes them half-cousins. All the
red is gone, as the DNA is consistent with the new tree. Charting Companion’s DNA Matrix chart
revealed a secret that would otherwise have been lost forever. We all had a chuckle, ever so grateful
to our grandmother, for had she done anything differently, we would not exist!
Try the DNA Matrix on your own tree to prove your research.
Note: that you need Charting Companion version 7 to run this DNA chart. Charting Companion
can run stand alone and also as a plugin for Family Tree Maker 2017.
Charting Companion works with all genealogy programs: Family Tree Maker, RootsMagic,
Legacy, Ancestral Quest, Family Historian, GEDCOM, etc. You can also download your Ancestry,
FamilySearch or MyHeritage GEDCOM file.
Get Charting Companion today and make family history. Charting Companion is compatible with
Windows Vista, Windows 7, Windows 8 and Windows 10. Unfortunately, it does not run on a Mac.

Pierre Clouthier									

President, Progeny Genealogy
https://progenygenealogy.com/
This article was written by Progeny Genealogy and is reproduced with their permission.		
												GUM

WANTED
Not for King and Country
or even as a Bush Ranger
We need you for help in the VicGUM office.
Great company and a chance to talk to other members.
No experience necessary and training given.
Can you spare some time to support VicGUM?
Once a month, once a year, or more if you get the bug, on a

Wednesdays 10:30 am – 2:30 pm
What will you do if you volunteer?
Answer the phone.
Check the answering machine
Check the mail.
Record the day’s activities.
Take renewals from members.
You will always be with an experienced volunteer.
So, come and give it a try or we may have difficulties keeping the office open!!!
		

Come in one Wednesday and see the office in action.		

If you can help contact Jim HILL on 0405320762 or scarsisbrick46@outlook.com
												GUM
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Doncaster Genealogy Group
Robyn and I are members of the Doncaster Genealogy Group, which meets at the Doncaster
Library, 687 Doncaster Road, Doncaster, at 10.30 am on the third Tuesday of every month.
There are seventeen members of this group, which was created more than ten years ago by one of
the library staff who was a keen genealogist. I think that Doug Elms may have given a talk on FTM
to this group some time ago?
Two years ago, just after Robyn and I joined, there was a change of library staff. The originator
of the group left, and there was no one with similar genealogy skills to take over, and who was
familiar with the range of genealogy reference books held in the area where we met. The group
continued to meet, with minimal guidance from the library assistant. Last year it became obvious
to me that the group had become a ‘self-help’ group, and with that in mind, I suggested that we
should develop a program of topics for the ensuing year, which would give us a focus for each
meeting. This we duly did, and I also became the unofficial point of contact for all the members.
At the next meeting the library announced that because the group was 'now a self-help group', it
would no longer be run as an official library-sponsored organisation. The room which the group
had occupied for all their meetings would no longer be available, and future meetings would be held
in the main library downstairs where an area would be set aside for us. This, as you might imagine,
caused a furore. Some of the members were quite vocal about the fact that we had to move from the
area where all the genealogy reference books were kept, and to conduct a meeting in an open space
rather than an enclosed room where voices could be more easily heard.
Anyway, we duly moved, and apart from having to contend with a bevy of small Asian children
singing nursery rhymes for half an hour in another area nearby, we have managed. In some ways
the facilities are better because we have access to the internet and an overhead projector which
works every time (unlike the room upstairs where the screen was a bit dodgy), the library staff
are only a few metres away if we need assistance, and we have amplification for our presenters; so
everything seems to have settled down.
Our program this year has covered things like organisation of documentation, which Robyn and
I led the discussion on, researching convict ancestors for one of our members, the use of Trove,
Norfolk Island ancestors, and in this month of July, Robyn presented a talk on FTM to the smaller
group of FTM users, in which she covered the basics of the program, and answered questions. There
was a lot of interest, as all present had the program. Robyn promoted John Donaldson’s handbooks
as a valuable guide, and of course membership of VicGUM.
One of the issues with Robyn being a member of this group is the clash with her obligations to the
VicGUM committee which meets at the same time, so at present she alternates month about with
each group.

Ron Pidcock, OAM										GUM
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The Forever Notebook
Cloud Connected Reusable Notebooks
As family history researchers, we are forever taking notes about snippets we discover; notes from
lectures we attend; diagrams of how locations, or where people might fit in to our tree; etc; etc ......
I have many notebooks and scraps of paper that contain an absolute gold mine of information that
I occasionally re-read, but not nearly enough to ensure I do not miss important tidbits. My notes
are organised only in the order that I have collected them. There is no cross referencing or indexing
as per normal with hand-written notes, so should I remember that I may have some information in
one of my notebooks, it is a case of search the lot in a vain hope that I may find it again. The other
problem with searching like this, is that during my search of the notebooks, I come across other
interesting tidbits that have nothing to do with my current line of research which are so tempting to
follow. Who was it that calls these finds, BSO's?- "Bright Shiny Objects".
I was listening to a webinar the other day and they made mention of a product called "Rocket Book".
The book is 32 pages long, written on with Pilot "Frixion" erasable ball point pens, but the amazing
thing about this book, is the pages can be wiped clean and re-used. A bit like a whiteboard or those
erasable books we had as kids. But what about the data/information we have meticulously recorded
on these pages I hear you ask? Well, here is the really nifty bit. There is an app (well there has to
be some sort of app these days) for both Android & Apple products that you use to record the data
on your pages prior to erasing. The app automatically takes a photo of the page, enhances and
processes the document, then forwards the document to a document service of your choice, Google
drive, i-drive, Evernote, Onenote, etc. It can even run character recognition on your document so
that it can be electronically searched. The accuracy of the recognition is directly proportional to the
legibility of your hand writing. Note: It did reasonably well with my writing and my wife tells me
that in a former life I must have been a doctor as my hand writing is a tad difficult to decipher at
times.

How it Works.
1.

Put Pen to Paper.

Using the Frixion pen make your notes on the Rocket
Book pages.

2.

Choose a Destination

At the bottom of each Rocket Book page there is a row
of symbols. Each symbol is configured within the app
as a destination for your document. You can send your
document to more than one destination by checking one or
more symbols at the bottom of the page.

3.

Scan your Pages

You now utilize the app on your phone or tablet to scan
your page(s). It will automatically scan, crop, enhance and
process your page(s).
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4. Blast your notes to the cloud
Once the app has finished the processing of your page(s) it will
then automatically send them to the destination you checked at
the bottom of each page.

Technical Details
1.

App Availability

The app is available for Android and IOS
2.

Cloud Services currently available:

Evernote; Box; Slack; email; Dropbox; Google Drive; OneDrive; Onenote; Trello; Photo

3.

Web Site:

https://getrocketbook.com.au/

4.

Pricing:

The current price (as at 16/7/2019) is $55 for the notebook which includes a pen and a microfibre
cloth. Additional pens are available from Officeworks for around for $3 each.

Disclaimer:
(This is not paid political propaganda. I have no affiliation with the makers of Rocket Book
whatsoever. MK)

Malcolm Kingston										GUM
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Notice of 35th Annual General Meeting
Sunday, 25th August 2019

Pursuant to the provisions of the Rules of Victorian GUM (Genealogists Using Microcomputers)
Incorporated , notice is hereby given that the Annual General Meeting of Victorian GUM
(Genealogists Using Microcomputers) Incorporated will be held in the Waverley Masonic Centre,
318 Stephensons Road, Mount Waverley; (Melway® 70 E2) on Sunday 25th August 2019 commencing
at 2:00 pm.

Items of Business
1.

To confirm the Minutes of the previous Annual General Meeting. (23 September 2018)

2.	To receive and consider the financial statements of the Association for the year ending
30th June 2019 which will be presented on the day.
3.

To receive the report from the Committee of Management.

4.

To present Service Awards as determined by the Committee.

5.

To present an Honorary Life Membership Award to a GUM member.

6.	To hold an election to fill the Committee positions, for the coming year, of President,
Vice-President, Treasurer, Secretary and general Committee Members up to the maximum
of eight.
Nominations for any of the positions as a Committee Member are invited from current members.
NOTE: All present Committee members retire in accordance with Rules 50 and 55 of the
Association. In accordance with Rule 55(2) all committee members may offer themselves for
re-election.
By Authority of the Committee

Notes:
 N
 ominations for the positions must be made in writing, signed by two Association members,
accompanied by the written consent of the candidate (which may be endorsed on the form
of nomination), and delivered to the Secretary not later than 2pm, Sunday 18th August 2019.
Nominees and nominators must be current members of the Association.
 Nomination forms may be obtained from the Secretary or the VicGUM Website (see next
bullet point). If insufficient nominations are received to fill all vacancies on the Committee,
the candidates nominated shall be deemed to be elected and further nominations may be
received at the annual general meeting.
 R
 efer to the proxy form for methods of advising the secretary by 2:30 pm on Wednesday the
14th August 2019

Download the Proxy form here:
https://www.vicgum.asn.au/images/documents/AGMProxyForm2019.pdf

Download the Nomination form here:
https://www.vicgum.asn.au/images/documents/AGMNominationForm2019.pdf
Note: The list of current committee members is listed on page 33 of this newsletter.
												GUM
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Pssst! Want to Buy Your Family’s Coat of
Arms?

I

n many shopping malls across America,
you will see pushcart vendors selling
reproductions of coats of arms, claiming
to be the “proud history and heritage of
your family name” or similar words. These
merchants sell coats of arms on parchment
paper, suitable for framing. They also may
sell coats of arms on t-shirts, sweatshirts,
golf jerseys, stationery, coffee mugs or even
key chains.

Similar “businesses” exist on the Web. A
number of Web sites proclaim that they
can sell you “authentic” copies of your
family’s coat of arms. One Web site says,
“What is your Name? What was it’s origin?
Was it taken from the name of a village?
Was it taken from the Bible? A clan name?
An Occupation? An ancient landmark?
Who were your historical namesakes who bore your fine family name in the homeland of your
ancestors?” Sometimes they also claim to sell “gifts of lasting heritage.”
I have one thing to say to these con artists: “Balderdash!”
Actually, that’s not my first choice of response, but, after all, this is a family newsletter.
The study of coats of arms is called heraldry. Those who control the issuance of arms are the
heralds. Typically, each country in Western Europe as well as in England, Scotland, and Ireland has
an office of the heralds, sometimes called the Kings of Arms. The heralds are empowered to decide
who is authorized to display a certain coat of arms. If you do not have authorization from the
heralds, you are not authorized to display any coat of arms. That authorization must be on paper,
signed, and made out to you personally, not to your entire family and never to everyone of a certain
surname.
Most Americans seem ignorant of one very basic fact: in Western Europe and in the British Isles,
there is no such thing as a “family coat of arms.” A coat of arms is issued to one person, not to a
family. After that person is deceased, his eldest heir may apply for the same coat of arms. Again,
when he dies, his heir may apply. The rules for determining who is eligible to display a coat of arms
are very similar to the rules for becoming King or Queen of England. However, even the proper heir
cannot display the coat of arms until he or she has received authorization (been confirmed) by the
heralds. At any one time, only one person may rightfully display a coat of arms.
According to the American College of Heraldry, “While Americans are usually fascinated by the
beauty of heraldry, they are rarely familiar with its meaning and traditions and, therefore, often
misunderstand and even abuse this rich cultural heritage. They seldom understand that a coat of
arms is usually granted, certified, registered or otherwise recognized as belonging to one individual
alone, and that only his direct descendants with proven lineage can be recognized as eligible to
inherit the arms. Exceptions to this rule are rare.”
The American College of Heraldry also says,” It is highly inappropriate for one to locate the arms
of another person sharing the same surname, and to simply adopt and use these arms as one’s
own.” My interpretation of this is that, if you are displaying an unauthorized coat of arms, you are
impersonating someone else.
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You can read more on the American College of Heraldry web site at
http://www.americancollegeof heraldry.org/body.html
The College of Arms in England (the heralds for English, Welsh, Northern Irish, and
Commonwealth families) says (at http://www.college-of-arms.gov.uk/resources/faqs):
“There is no such thing as a ‘coat of arms for a surname’. Many people of the same surname will
often be entitled to completely different coats of arms, and many of that surname will be entitled
to no coat of arms. Coats of arms belong to individuals. For any person to have a right to a coat of
arms they must either have had it granted to them or be descended in the legitimate male line from
a person to whom arms were granted or confirmed in the past.”
Despite these warnings, many vendors are making money by preying on Americans’ ignorance of
the topic. The pushcarts you see in shopping malls typically are franchise operations. One pushcart
owner told me that he paid $6,000 for a “franchise” to sell this stuff. The so-called franchise did not
include a protected territory; another franchisee was free to set up business in the same area. For
the $6,000 investment, the franchisee receives a computer with a database containing thousands
of surnames and so-called “family coats of arms,” a high-quality printer, a supply of parchment
paper (actually not parchment but simply paper that has been treated to look like parchment), and a
supply of coffee cups, key chains and other paraphernalia. These franchisees reportedly receive no
training in the study of heraldry. The ones I have talked to didn’t recognize the term,
“College of Arms.”
The Web sites aren’t much better. The ones I have looked at seem to have carefully-worded claims.
Instead of saying, “your family’s coat of arms,” they will say something like “your historical
namesakes.” Okay, “namesakes” doesn’t mean “ancestors,” but it still will be misleading to many
people. When a Web site proclaims, “your historical namesakes,” most people will think that
means “my family.” However, if argued in court, the wording on the Web site would probably be
considered correct. In short, I doubt if these companies will be shut down for misrepresenting their
wares as they are very careful in their choice of words.
The next time someone offers a copy of your “family’s coat of arms,” ask them for the
documentation. They won’t have any. If a friend of yours is displaying a coat of arms on his
stationery or on his fireplace mantel, I suggest you simply walk away smiling. There’s no sense
in upsetting a good friendship. But don’t be as gullible as your friend. And please, please do not
display your “family’s coat of arms” on your genealogy Web site unless you have been confirmed by
the heralds. Okay?
If you would like to learn more about the serious study of heraldry and any rights you might have
to display coats of arms, there are a number of Web sites devoted to the truth. Here is a short list of
some of the more reputable ones:
The College of Arms (the official repository of the coats of arms and pedigrees of English, Welsh,
Northern Irish and Commonwealth families and their descendants) at:
http://www.college-of-arms.gov.uk/
The Augustan Society at: http://www.augustansociety.org
The American College of Heraldry at: http://www.americancollegeof heraldry.org/
The Baronage Press at: http://www.baronage.co.uk/
British Heraldry: http://www.heraldica.org/topics/britain/ and especially the article on “Regulation
of Heraldry in England” at http://www.heraldica.org/topics/britain/england.htm
None of the above sell printouts on parchment paper, t-shirts or key chains. Some of them do sell
books and magazines devoted to the study of heraldry, however.
Any site that purports to sell “your family coat of arms” is a rip-off. Don’t waste your money.

Dick Eastman										GUM
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GRAMPS and Other Genealogy Programs
in the Cloud
GRAMPS (an abbreviation for “Genealogy Research and Analysis Management Programming
System”) was originally developed as a rather full-featured Linux genealogy program and later was
ported to Macintosh, Windows, BSD UNIX and Solaris. GRAMPS is always available free of charge.
(You can find my previous articles about GRAMPS by starting at https://goo.gl/gVUE9d.)
GRAMPS also has been
available as a cloud-based
program for some time.
In theory, you should
be able to use the cloudbased version of GRAMPS
with any Android, Apple
iOS (specifically iPad),
Chromebook, Windows,
Macintosh, or Linux
computer. Since it runs
from the cloud, no
software installation in
your computing device
is required. Best of all,
GRAMPS is available FREE
of charge.
I wrote about the cloud
version of GRAMPS some
time ago at: https://blog.
eogn.com/2016/09/14/
gramps-can-now-be-usedas-a-cloud-based-genealogyprogram/.
The subject of finding full-featured genealogy programs in the cloud arose again this week so I
thought I would mention the earlier article again. You can read my original article at https://blog.
eogn.com/2016/09/14/gramps-can-now-be-used-as-a-cloud-based-genealogy-program/ although I
will say that the cloud version has matured a bit since I wrote that article nearly 3 years ago.
You can find dozens of other genealogy apps in the Apple iPhone and iPod App store as well as in
the Android Play Store. However, most of these apps are not nearly as powerful as GRAMPS.
In addition, if GRAMPS doesn’t meet your needs, you might investigate the The Next Generation of
Genealogy Sitebuilding© (“TNG”) at http://www.tngsitebuilding.com/ and webtrees(aways spelled
with all lower-case letters) at https://www.webtrees.net.
A modern mother is explaining to her little girl about pictures in a family photo album.
“This is the geneticist with your surrogate mother
And here’s your sperm donor
And here is your father’s clone.

This is me holding you when you were just a frozen embryo.
The lady with the very troubled look on her face is your aunt, a genealogist.”
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Both The Next Generation of Genealogy Sitebuilding (“TNG”) and webtrees are MULTI-USER
genealogy services that can be installed in a web server that you own or rent. You could have dozens
or even hundreds of cousins or other genealogists using the program simultaneously!
Installing and configuring either The Next Generation of Genealogy Sitebuilding or webtrees
is somewhat more complicated than the many smaller and less-powerful Android and Apple
iOS apps. However, there is a less-complex solution: Rented web server space is available from
several different companies for about $6 US a month or a bit more and some of those same server
companies will even install the software for you.
Hosting information for users of The Next Generation of Genealogy Sitebuilding© (“TNG”) may be
found near the bottom of http://www.tngsitebuilding.com/.
If you prefer a host that specializes in webtrees, the following page lists some suppliers able to
provide one for you: https://www.webtrees.net/index.php/en/web-hosting-en.

Dick Eastman										GUM
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We tested 5G speeds in 13 cities.
Here’s what we found

Faster speed versus more coverage. That’s the most important issue for 5G
networks today
Raindrops splat the pavement in downtown Chicago as I balance an umbrella in the crook of my
arm and phones in each hand. On my left, I’m downloading the PUBG Mobile game over Verizon’s
5G network. On my right, I’m timing how long it takes to install: 2.5 minutes (versus 6 minutes on
4G). What’s so exhilarating about this moment has less to do with the progress bar on my screen
and more to do with bearing witness to one of the first live 5G networks anywhere in the world.
After years of hearing how 5G is poised to change our lives with lightning-fast phone download
speeds, and crisp, super high-resolution video calls, AR apps, and real-time gaming that are all lagfree, 5G is finally real. But it’s far from stable — and stability is the one thing 5G desperately needs.
On its surface, 5G is about astounding speeds and almost zero latency — the lag time between when
your phone pings the network and when it responds. But on a global scale, it represents political
dominance and economic might. Nowhere is that point drawn more clearly than in President
Donald Trump’s increasing interest in 5G, which so far includes stopping a buyout to keep US
chipmaker Qualcomm independent, signing an executive order to ban No. 1 5G infrastructure
company Huawei from operating with US companies, and even pushing for 6G upgrades as quickly
as possible. (6G doesn’t exist yet.)
5G networks around the world are sprouting up as pinpricks in cities and neighbourhoods, largely
acting as hotspots that will give your phone some impressive juice if you’re standing in just the right
place with just the right device. But move a block farther, enter a building or hop into a car and that
5G connection is just as likely to revert to 4G. Or the connection might hiccup and lose its grasp on
5G on its own.
5G indicators like this one are a badge of pride for carriers hoping to sell you on their faster
networks.
By now, my fellow CNET editors and I have gotten an extensive first-hand taste of 5G on seven
networks, in 11 cities spanning Los Angeles to Seoul, with four brands of phones. We’ve conducted
dozens of speed tests on the benchmarking app Speedtest.net and downloaded movies and apps
dozens of times from services like Google Play, Netf lix and Amazon Prime.
We’ve seen an almost two-hour movie download in 8.2 seconds, and witnessed speeds almost 20
times faster than what you might see on your 4G phone (a 5G peak of 1.8Gbps so far). But we’ve
also seen 5G stall, lag and cut out completely as undersung and overworked techs scrambled to keep
these nascent networks up and running.
At this point in the game, anyone could win the race to stable 5G first —but some are in a better
position than others.

Early 5G winners and losers
Everything could change as 5G development continues, but in these early days, some have pulled
ahead while others have fallen behind.
South Korea, winner: While Verizon pooh-poohed South Korea’s claim of being the first in the
world to 5G with three carriers giving their fastest phones to six celebrities, the country’s Ministry
of Science and Technology reported that 1 million people signed up for 5G in 69 days, a faster rate
than the country’s 4G rollout.
SK Telecom’s peak speeds in our downtown Seoul tests.
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Samsung, winner: Speaking of South Korea, the world’s largest phone-maker has populated
carriers worldwide with its premium Galaxy S10 5G phone, which is available on 14 networks all
over the world, including the four major US carriers, as of Friday. It also sells from Samsung.com in
regions that already have 5G or soon will, and through various retailers. It’s one of the first, most
powerful phones to work with 5G, a feather in Samsung’s cap.
Qualcomm, winner: The world’s largest mobile chipmaker has been talking up 5G for years, and
now that it’s live, the company appears to have a dominant position in the field. With the exception
of Huawei, every 5G phone contains a Qualcomm chip. A gathering of dozens of carrier, handset
and equipment executives on a Qualcomm stage at Mobile World Congress showed off just how
critical the company is to the mobile industry.
The Motorola 5G Mod and Galaxy S10 5G devices that tap into Verizon’s 5G network both run on
Qualcomm’s modem.
Telstra, winner: Australia’s carrier has three 5G phones — the LG V50 ThinQ, Samsung Galaxy
S105G, and Oppo Reno 5G — and 10 major 5G areas: Adelaide, Perth, Sydney, Toowoomba,
Launceston, Melbourne, Hobart, Gold Coast, Canberra, and Brisbane. That’s impressive for a
continent with a roughly 3 million square mile area — just about the same as the contiguous United
States.
Huawei, loser: Although Huawei is the world’s largest maker of 5G networking equipment, the US
action against the company — a result of its alleged coziness with the Chinese government — puts
its entire business at risk.
As the US pressures other countries to follow suit, Huawei founder and CEO Ren Zhengfei said he
wasn’t worried about the $30 billion that Huawei might lose as a result of the US ban. The company
instead doubled down on its 5G investment, though its future is up in the air. Huawei did not
respond to a request for comment.
Apple, loser: The iPhone is behind the 5G curve. Unlike rivals, Apple has not yet announced its 5G
plans. Mired in a legal battle with chipmaker Qualcomm until April, Apple was originally planning
to use Intel to bring the iPhone to 5G. After the settlement, Intel immediately dropped out of the
5G game, and the iPhone isn’t speculated to get 5G until 2020. If Apple sticks to its September cycle,
it’ll trail Samsung by a year and a half. The Cupertino brand may not even get its own 5G chip until
2025. Apple did not respond to a request for comment.

Confusing technology: A tale of two 5Gs
It isn’t easy to wrap your head around 5G, and that’s because it doesn’t just mean one thing. You
could have ultra-fast speeds in a tiny area or pretty-fast speeds in a wider area.
Scratch the surface and 5G, which stands for fifth-generation mobile network technology, is an
insanely complicated orchestra of towers, nodes, beams and devices all using radio airwaves all at
once.
It’s which slice of the radio frequency, also called spectrum, a carrier will use that makes the
difference in the 5G experience you get. For example, Verizon’s Ultra Wideband and AT&T’s Plus
f lavour of 5G use millimetre wave (mmWave), which runs at an extremely high frequency that
shoots powerful signal a short distance away, and not through glass or buildings. This is where you
see those ultra high speeds.
In this model, urban centres get the fastest 5G, with outskirts on Sub-6 GHz (“mid-band”)
spectrum. More rural areas will get ultra-fast LTE for now.
On the other hand, another swath of spectrum known as “sub-6 GHz” or just “sub-6” — the socalled midband frequencies — to give you more coverage, though speeds won’t be nearly as high.
You’ll see that and mmWave ref lected in our peak speed results below.
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In due time, some networks will join these approaches in their quest for fast, expansive 5G, even
dipping into low-frequency bands to solve the problem of coverage over larger areas and through
buildings. For example, T-Mobile has quietly turned on its mmWave-based 5G network now but
plans to more publicly launch its next-generation service on the lower-frequency 600 MHz band in
the second half of the year, when devices become available.
Our glossary of popular 5G terms will explain a lot, and here’s one of the easiest to understand
primers of mmWave and sub-6 to date. The speeds: Awe-inspiring, sometimes.
We conducted scores of 5G speed tests in Chicago, Los Angeles, Dallas, London and Sydney using
the Speedtst.net benchmarking app.
If you’re solely looking at peak speeds, AT&T in LA easily reached the zenith, resulting in download
speeds over 1.4GB/s in 8 out of 12 tests. Verizon was right behind, with a peak of 1.3GB/s down and
multiple results over 1Gbps in several areas of downtown Chicago.
Sprint (Dallas), Telstra (Sydney) and EE (London and four other UK cities) used midband spectrum
to achieve speeds in the 400 to 500 MB/s range, which might still be two to four times faster than
your 4G phone and faster than your home Wi-Fi connection. (Average AU NBN is 50 MB/s Ed).
The progress is extremely promising in this nearly-pristine state with few real users. The real trick
is for carriers to sustain these speeds once more subscribers join up and start clogging the lanes.

Global Field Tests: Peak 5G Speeds
Location

5G
technology

Phone

Test date

AT&T
Verizon
SK Telecom
T-Mobile
Telstra
Telstra

Peak
download
speed
(Speedtest.net)
1.8 GB/s
1.3 GB/s
618 MB/s
583 MB/s
489 MB/s
485 MB/s

Los Angeles
Chicago
Seoul
New York
Sydney
Sydney

mmWave
mmWave
Sub-6GHz
mmWave
Sub-6GHz
Sub-6GHz

Galaxy S10 5G
Galaxy S10 5G
Galaxy S10 5G
Galaxy S10 5G
Oppo Reno 5G
LG V50

June 22, 2019
May 16, 2019
June 27, 2019
June 28, 2019
June 20, 2019
June 14, 2019

Sprint
EE

484 MB/s
460 MB/s

Dallas
London

Sub-6GHz
Sub-6GHz

LG V50
May 30, 2019
OnePlus 7 Pro 5G June 15, 2019

The coverage: We have a long way to go.
The most valuable lesson we learned from our 5G field tests is that reliable, consistent coverage
matters more than lightning speeds when it comes to a satisfying experience.
While the carriers build up 5G day by day, most of these towers and nodes are sprinkled across
urban centres, which means you won’t get blanketed coverage as you move throughout the day, at
least not yet.

Jessica Dolcourt Cnet.com									GUM

Hi all Reunion 12 for Mac users
In case you missed it, the latest update of Reunion 12 was 22 July 2019.
Here’s the link to download
			http://www.leisterpro.com/doc/v12/download.php

		

GUM
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Joshua, His Wives And His Children

oshua Hull (recorded in the Parish Transcript as Hall – I am hoping this is a transcribing error)
was born in Lidlington, Bedfordshire, England to parents Joshua and Susan and was baptised on
8 Dec 1751 or maybe he was born in Eaton Socon, another Parish in Bedfordshire, to parents John
and Elizabeth and baptised on 15 July 1744.
But let us start with John Cowland and Ann Chambers. John and Ann married in Southill,
Bedfordshire on 21 September 1766. John died in December 1768 and was buried in Southill on 11
December 1768.
On 20 February 1770, in Southill, Ann Cowland (described as a widow in the Church Banns and
marriage records) married Joshua Hull. The records state that both were “of this parish”, that is,
Southill.
Ann died just short of a year later, being buried in Southill on 8 February 1771. The Church burial
record states that Ann was the “wife of Joshua Hull”.

About 17 months after the loss of his first wife, Joshua (described in the church records as a
widower), married Ann Dilly on 13 July 1772 in Southill. Again, both were described as being “of
this parish”.
After nearly 14 years of marriage, Joshua’s second wife, Ann, died and was buried in Southill on
17 March 1786. The Church burial record states that Ann was the “wife of Joshua Hull”.
I have not yet found any records of children being born to Joshua and his first wife (Ann Cowland
(Chambers) or to Joshua and his second wife (Ann Dilly).
On 19 July 1787, Joshua (again described as a widower) married Sarah Williamson in Southill. And
again, both were “of this parish”.
Joshua and Sarah had at least four children, John, Joseph, Ann and Mary. John’s birth was
registered on 26 November 1791 in the Southill Baptist church with his date of birth recorded as
3 November 1791. Joseph’s birth was registered on 17 March 1794 in the Southill Baptist Church
with his date of birth being recorded as 3 February 1794.
I have not yet found any birth or baptism records for Ann and Mary, apart from the baptism record
referred to below.
Joshua, the father of Ann, Mary, John and Joseph (all probably under the age of eight), died in
January 1798 and was buried in Southill on 14 January. Then, their mother, Sarah, died in June 1798
and was buried in Southill on 5 June.
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What happened to these four young children?
Well, we do know that somebody (perhaps relatives, neighbours or friends or the Church or
whoever had taken on the responsibility of caring for the young children) arranged to have all four
children baptised. Ann, Mary, John and Joseph were baptised in All Saints Church, Southill on
13 October 1798, some four months after their mother died. The original Parish record states that
Ann, Mary, John and Joseph were the “children of Joshua and Sarah Hull”.
I have copies of the original parish records recording all of these events and the dates except for the
possible births of Joshua – here I rely on the Parish Transcripts.

Things now become somewhat confused for some family
historians and other researchers.
If we look at this part of the (Mormon) FamilySearch Family Tree, we see that Joshua and Sarah
supposedly had two children named Joseph, two named Mary, three named John, two named Ann
and one without a given name but with a death/burial date. Joseph, John, Mary and Ann all have
birth/baptism dates of 13 or 18 October 1790.
Ann, John and Mary have birth/baptism dates of 13 or 18 October 1798 (as should Joseph, but he
does not). John has a birth date of 3 November 1791 (and this is correct). Joseph should also have
his correct birth date of 3 February 1794, but this is missing.
There is also a “child” who does not have a given name but has a death date of 17 March 1786.
This is the burial date for Ann Cowland (Chambers), Joshua’s first wife, so I assume somebody has
accidentally added this detail to Joshua’s and Sarah’s record.
As I claim above, 13 October 1798 is correct for all four children, 3 November 1791 is correct for
John and 3 February 1794 is correct for Joseph, but why do we also have a 1790 date for all four
children and a 1799 date for Joseph?
I believe transcribers and researchers have simply misread the figures in the dates.
Around this time, 1798, the figure 8 was written almost on its side, nearly horizontal rather than
vertical with the two circles one above the other as we now write it. In many cases that I have found
in original church records in Bedfordshire and later in New South Wales, the circles are often not
closed and the figure can be confusing until you compare it with dates before and after.
In the entry for the children’s baptism on 13 October 1798, the figure 8 is also poorly written,
being almost on its side, but with the lower or left circle not completed, not fully closed so that the
figure could look like a zero with a funny “tail” running off and up to the left. I suppose this can be
interpreted as a zero, hence people arrive at a date of 1790, but we have quite clear records from the
Baptist church in Southill registering John’s birth as 3 Nov 1791 and Joseph’s birth as
3 February 1794.
They cannot have been baptised before they were born. Some people have also interpreted the 8 as a
9, giving a date of 1799.
And some people have interpreted the 13 in 13 October 1798 as 18, but it does not resemble any of
the 8s in these records and clearly looks like a nearby 3 in another record.
So, I am persuaded that there are sufficient Church records establishing Joshua’s marriages and the
four children with his third wife Sarah Williamson and the correct date of the baptism of all four
children as well as the birth dates for John and Joseph.
Why am I interested in Joshua, his wives and his children? Because I am Joshua’s 4x great grandson.

David John Hull, Canberra, July 2019							
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Battery leakage redux:
Duracell sends in the bunny
In July (page 23) I reprinted an article concerning battery leakage. Here is the
interesting follow-up by the same author
There are the things that happen for consumers who make complaints, and then there are the
things that happen for people who write for major websites and newspapers and make complaints.
I take the consumer route every time because it tells me how companies treat my readers. So when
I complained about leaking Duracell batteries that had a use-by date of March 2024 I raised the
matter as long-time consumer of them, not as a journalist.
In May I wrote about the reply I received from the company. Its customer service people told me
the company appreciated my message and was concerned. Just not concerned enough to offer me a
couple of AAA batteries to replace my leaky ones. Apparently I should have known about removing
batteries from devices that were not being used for a few months. Duracell appeared unfazed about
its batteries leaking.
The company referred me to an ‘enclosed’ pamphlet on battery care. Given that this was an email
the use of the word ‘enclosed’ was puzzling, and no pamphlet was attached to the email. Nor did
one follow by mail.
Anyway after the story was published and Duracell realised I was a journalist I was contacted by
Nihan Belik Guneri, the company’s marketing and commercial strategy director in Singapore. She
apologised for my experience, offered to replace the batteries and the device they were in (which
experienced minor, unfatal damage) and asked me to send the leaking batteries in for examination
by a quality team. She also arranged a call to Yanira Wells, Duracell’s R&D director for Asia and
Australia, who is based in Connecticut, USA.
So I mailed the batteries in and took the conference call from Singapore and Connecticut.

A bunny for my trouble. CREDIT:ROD EASDOWN

Various scenarios were put to me about the cause of battery
leakage, like mixing old and new batteries or batteries of
different type, or leaving expired batteries in devices, or
leaving good batteries in devices that are not being used for a
few months. I admitted to that last charge in my original story.
I guess if I had received Duracell’s ‘enclosed’ pamphlet I
would have known all this. I mentioned the pamphlet to Ms
Belik Guneri and she seemed to have no knowledge of it, but
promised to check with the customer relations folk. It turned
up by email a few days later.
Then I received the replacements for my two leaky AAAs; 32 AAs, 16 of them long-life Ultras that
‘last up 100 per cent longer’ and 16 regulars that ‘last up to 50 per cent longer’. (Longer than what?
Ed). Also enclosed, a Duracell bunny and a hand-written note saying that the company hoped I’d
enjoy it all. Duracell has dropped a use-by date on these ones.
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Meanwhile I’ve received a slew of messages from readers, and they’re still coming. Lots have
experienced leakage with Duracells that in some cases ruined the devices they were in. One reader
reported leakage from an Energizer. Lots of people swore by batteries of other brands, ranging from
Vartas to K-Mart. Eneloop rechargeables got a big tick from readers.
I sympathise with my readers because I’m pretty sure none of them would have received the
attention I got. Duracell’s reaction to me as a reporter for major newspapers and websites was
markedly different from its reaction to me as a plain old consumer. Forgive my cynicism, but if I
was not a reporter in a big city there’s no sign the matter would have gone any further than it had
when I first wrote about it.
You can read Duracell’s ‘Tips for proper battery care and use’ at:
http://www.rodeasdown.com.au/home-entertainment/4507/

Rod Easdown											GUM

Another Method of Sending Large Files
to Others

Sending large files, pictures, or videos to someone else or even to yourself (for copying a file to
another computer) has often been difficult. Sending files by email often is limited by the size of the
file(s) to be sent. In the past, the only method of sending large files was by FTP file transfers or by
questionable P2P (peer-to-peer) programs. Luckily, technology has moved on and today it is easy
and cheap to send large files, such as family photographs, large GEDCOM files, and even videos of
your grandchildren you want to share with other relatives.
Sharing files has long been easy for smaller files but with limitations. For instance, the various
methods of sending files often have maximum file size limitations.
Next, sharing files by Dropbox is exactly that: sharing. While you can technically share files
hosted on Dropbox, any edits or changes affect the file for all users. If someone uploads a file and a
recipient then deletes it, the file is deleted for everyone.
A better solution has just been announced, called Dropbox Transfer.
Dropbox Transfer is available to all Dropbox customers, including both free and paid users of
Dropbox. The original file remains on the sender’s Dropbox for the sender to do with as he or she
pleases. If the sender then deletes the file(s), anyone who was sent a copy via Dropbox Transfer can
still download that version. The big difference between Dropbox Transfer and other file-sharing
services is the data limit: Dropbox Transfer lets users send files up to 100 gigabytes in size for free.
To use Dropbox Transfer, you must be a Dropbox user. The new service will work on Windows or
Macintosh. You might want to be aware that Dropbox Transfer is still listed as being in beta test.
However, in my admittedly brief testing, it seemed to work perfectly.
You can read more in the Dropbox Transfer web page at:
https://www.dropbox.com/transfer/about?_tk=blog&oqa=193pl12mbbody
Of course, Dropbox isn’t the only service that can be used to send large files. For instance, I wrote
about Send Anywhere in an earlier EOGN article at:
https://blog.eogn.com/2017/01/19/use-send-anywhere-for-secure-sending-of-files/.
You can also read about several other competitive services by starting at:
https://duckduckgo.com/?q=%22send+large+files%22+free&atb=v132-2_j&ia=web

Dick Eastman										GUM
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GUM will be at the:
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Unlock the

power of DNA
to further your research!

Join us on a fantastic journey as we help you
solve your family mysteries with DNA

plus experts

with Blaine Bettinger

Louise
Coakley

International DNA genetic genealogist

Learn from some of the world’s best experts
on DNA and genealogy. Immerse yourself in

Michelle
Patient

the world of DNA and discover the potential
it offers to further your research.

Single Day Event

DNA to the

MELBOURNE

MELBOURNE + SYDNEY

• Beginner & expert sessions
• Explore the exhibition
• Societies, DNA interest
groups, suppliers and more
• Hundreds of $$$ in prizes
• Light lunch included

1 Day
2 Streams
4 Speakers
10 Topics

• Beginner & expert sessions
• Explore the exhibition
• Societies, DNA interest
groups, suppliers and more
• Thousands of $$$$ in prizes

• Light lunches included

www.dnadownunder.com
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PROGRAM
FRIDAY 23 AUGUST 2019
TIMES

FUNCTION HALL

ROOM 1 + 2

8.30am – 8.55am

Registration + Exhibition

8.55am – 9.00am

Welcome / Introduction

9.00am – 9.50am

Introduction to DNA — Blaine Bettinger

9.55am – 10.45am

Using Autosomal DNA for 18th & 19th century
mysteries — Blaine Bettinger

10.45am – 11.15am

Break + Exhibition

11.15am – 12.05am

Genetic genealogy: standards, ethics, risks,
limitations — Louise Coakley

12.05am – 12.15pm

Prize Draw

12.15pm – 1.15pm

Break + Exhibition

1.15pm – 2.15pm

Using GEDmatch & DNA Painter to analyse
your DNA — Blaine Bettinger

Which company to test with? Pros and cons
— Michelle Patient

2.20pm – 3.10pm

Verify a family line with DNA
— Louise Coakley

Getting the most from your Ancestry results
— Brad Argent (Ancestry)

3.10pm – 3.30pm

Break + Exhibition

3.30pm – 4.30pm

Limitations of cousin matching
— Blaine Bettinger

4.35pm – 5.30pm

The Helen Marley story: a case study
— Blaine Bettinger

5.30pm

Close

Exploring ethnicity estimates
— Michelle Patient

the program is subject to minor change

MELBOURNE INFO
WHERE: Jasper Hotel, 489 Elizabeth St, Melbourne VIC

Book Online at
www.dnadownunder.com
or call 1300 526 069 for other booking/payment options

WHEN: Friday, 23 August 2019
A light lunch and morning and afternoon tea is
included with admission. The booking form allows
you to register special dietary requirements.

MELBOURNE ONLY
PRE-BOOK TO SECURE A PLACE AND BE IN THE PRIZE DRAW

PRE-BOOK PRICE

$155

BY WED 14 AUGUST

An exhibition with information, sales advice and special
offers will be open in the breaks.

MELBOURNE + SYDNEY
PRE-BOOK TO SECURE A PLACE AND BE IN THE PRIZE DRAW

Visit www.dnadownunder.com for full details

PRE-BOOK PRICE

$450

BY WED 14 AUGUST

GUM
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A

“John Charlton is my Great Uncle”

s the main historian for our family I was looking on the internet for family history when I
came across an article in a country newspaper, “The Granite News” about a window found
under the f loorboards of St Paul’s Anglican Church in Euroa, Northern Victoria.
The person was asking any interested members of the Charlton family connected to Euroa,
to contact her. My maiden name was Charlton and I was certainly interested. I contacted the
researcher and have been in contact with her ever since. Maxine is an archaeologist and PhD.
candidate at Latrobe University. She told me about the window and took me to the country to see it
in all its pieces and dirt from about one hundred years of storage. It didn’t look like much of great
interest at this stage. The other researcher is Lynne, also an archaeologist. They have both worked
really hard to find out as much as possible about the window and its history. The third member of
the team is Bronwyn, an expert in stained glass.
As a family member my feelings regarding the window are of great pride that this window, which is
proving to be so beautiful, is being restored and will, once again, be seen as a memorial to my Great
Uncle John who died, with many others as a result of the Boer War.
I feel very sad for my Great Grandparents, Walter and Mary Charlton who lost not only their eldest
son in the Boer War, but two other sons, Francis and Robert, in the First World War. Walter and
Mary had two other sons, one of whom was my Grandfather William. William’s eldest son was my
father, Walter Adam Charlton.
I know that a mother never forgets a child who dies before her and I can imagine her sorrow when
the window was removed from the Church, never to be seen again. (Not in her lifetime anyway!).
The replacement Charlton Memorial window installed in St Paul’s Church Euroa in the 1930s
would have been some consolation to her. She would be very happy had she known that the original
window will soon be displayed.
The window has been restored thanks to a grant from The Department of Premier and Cabinet
and the Department of Veteran Affairs. I have been privileged to be able to watch the progress of
the project as it was returned to its former glory and to help fill in the background history of the
Charlton family. The colours and the intricacy of the window never cease to amaze me. The window
project was launched in November 2016. This was a memorable occasion and was made more so by
the presence of a guard of honour formed by the Royal Australian Armoured Corps, Puckapunyal.
The presence of nearly all of my immediate family, some of my cousins and other descendants made
it a special day too.
At last we know that this beautiful and historic window will have a permanent home in the Shrine
of Remembrance, Melbourne; a memorial to John but also to all the soldiers who died in the Boer
War. It was installed on June 2017 and is in the Boer war section at the Shrine for all to see.

Chris O’Brien										GUM
The window is on permanent display in the Boer War area of the Shrine of Remembrance in
Melbourne. It is very big, approximately 4.3 x 2.1 metres (14ft by 7ft) so is around the corner from
the cabinets in Boer War area as it required a large wall space. It is beautifully displayed with back
lighting and a board explaining the story.
Identifying me: The Governor of Victoria is on the right of the window and I am on the left side of
the window, (camel coloured coat). Left and right referring to left and right of the photo. C O’B.
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At the Shrine with the Governor

Completed Window

Window as first seen
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GUM Book

So you are Totally New to Family Tree Maker Book (now available)
New third edition. The first in a series about FTM, this book covers
the absolute basics for new users, so that users with little computer
knowledge can get up and running. New third edition Specifically
revised for FTM 2017 and is in full colour
Cost: $25.00 (plus Postage $4)

GUM CD
DVD

45 videos

Instructional Video
Second Edition 2.2
March 2018

© Copyright 2018

NEW and Revised GUM FTM Instructional CD Version 2.2
Second Edition (see page 15 of the November newsletter for details)
Exclusive to GUM. Contains 45 tutorials (up from 26) on using
Family Tree Maker 2017. Play them as often as you like.
			
A MUST for all FTM users!

			Cost: $10.00 (plus Postage $4)					GUM
Family Tree Maker
(Day)
The first Friday of the month at
Wadham House
1:00 pm start.
Cost $2.00
johndd@iinet.net.au

Self- Help Groups

Family Tree Maker
(Evening)
The third Monday of the month
at Wadham House
7:30 pm start.
Cost $2.00
ftmusers@vicgum.asn.au

Next Meeting 2019:
6 September
Reunion User Group

Next Meeting 2019:
16 September

First Friday of the month at a
private house Elwood
2:00 - 4:00 pm
Cost $2.00
reunionusers@vicgum.asn.au
Geelong & Bellarine
FTM Group

Next Meeting 2019:
6 September

Meeting the Third Sunday of

Meeting the third Monday of
each month at South Barwon
Community Centre,
Mt Pleasant Rd, Belmont
4:30 - 6:00 pm
Contact Maree

the month

marcusgrove10@bigpond.com.au

Next Meeting 2019:
16 September
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Ballarat FTM Group

GUM

At McDonalds (Golden Arches)
Sturt Street Ballarat.
at 1:00 pm
Contact Maureen
chatty44@bigpond.com
Next Meeting 2019:
15 September
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GUM MANAGEMENT TEAM
President
Doug Elms
03 9809 4854
Vice President John Donaldson 0438 670 003
Secretary (A/g) John Killip
03 9569 6137
Treasurer
Bob Mullner
03 9509 8129
Committee:
Laura Black
Malcolm Kingston

0425 703 350
03 8707 5994

Alyson Kosina
Margaret Ockwell
Robyn Pidcock
Bubbles Segall

0410 611 259
0417 161 112
03 9842 1036
0488 066 387

Membership Officer:
John Donaldson

0438 670 003

Office Manager:
Bob Mullner		
03 9078 4738
Wednesday (10:30 am-2:30 pm)
Merchandise Sales
03 9078 4738
& Distribution
email: 		
sales@vicgum.asn.au
Webmaster: webmaster@vicgum.asn.au
Any General Committee Enquiries

Victorian GUM Inc.

VICTORIAN GUM (GENEALOGISTS
USING MICROCOMPUTERS)
INCORPORATED
WEBSITE:
EMAIL:

www.vicgum.asn.au/
info@vicgum.asn.au

FACEBOOK: www.facebook.com/VicGUM
Reg No: A0023358X ABN 47 032 151 571
Level 4, 460 Collins St Melbourne 3000
[Enter from 83-89 William Street]
Postal Address:
PO Box 397 Collins St West VIC 8007
Phone:		
03 9078 4738
Office email: gumoffice@vicgum.asn.au

NEWSLETTER TEAM
Editor: 		John Donaldson
Proof Readers:
Cathy Carman
			Marjie Hales
			Tricia Parnell
			Yvonne Toomey

NEWSLETTER DEADLINES

GUMNET MAILING LIST

Final copy for each issue of Victorian GUM Inc.
News is due with the Editor by the first day of
the preceding month.

To post to GUMNET
gumnet@lists.vicgum.asn.au

NEWSLETTER CONTRIBUTIONS

info@vicgum.asn.au

CURRENT GUM LIFE MEMBERS
Bruce Fullarton
Merv Leeding
Laurie Thompson
Doug Elms

John Wolff
Robyn Fisher
John Donaldson

Registered by Print Post Publication
No. PP100018445 ISSN 1324 2652
© Victorian GUM Inc. and individual authors.
This newsletter may not be redistributed to
other parties by the original member who
received it.
Produced in Adobe InDesign CS6

Copy is preferred in electronic form and may be
sent to the Editor at PO Box 397 Collins St West
VIC 8007, or via email to:
editor@vicgum.asn.au.
Most file formats can be handled. If graphic files
are included in your article, (TIFF preferred),
please also send them separately and indicate
their placement in the text via a PDF of the
complete article.
Every effort is made to ensure that the
information in this newsletter is correct, but
no responsibility is accepted for errors or
omissions. The views expressed are those of the
individual contributors.
							
					GUM
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GUM Payment Options
Cheques and money orders (including the relevant postage) are to be made payable to
Victorian GUM Inc. and sent to: PO Box 397 Collins Street West VIC 8007. Credit card
facilities via telephone are available through VicGUM®, The Genealogical Society of
Victoria Inc. (GSV) in Melbourne. (The minimum amount is $10.00).
For details of what is available see the bottom of the VicGUM® merchandise page
(page 32) or ring the GUM Office 03 9078 4738 Wednesdays. 10:30 am to 2:30 pm; or go
to: www.vicgum.asn.au/ . Then click on Software & Sales.
Bank Account: Merchandise can be purchased via the GUM Website, through your bank
or by using your Internet banking facilities. The details you require are:
ANZ Bank
BSB 013-030, Account No: 79 87792
Please email details of your order to
sales@vicgum.asn.au
You can also pay with your credit or debit card using the secure PayPal facility.
(You do not need to have a PayPal account to do this).

												GUM

One Year

GUM Subscriptions

Joining Fee (once off)			
Yearly Subscription 				

$15.00
$50.00 (Includes 12 emailed newsletters)

Joint Members (2 members at the same address)
Joining Fee (once off)			
Yearly Subscription 				

$25.00
$65.00 (Includes 12 emailed newsletters)

Two Years
Joining Fee (once off)			
Biennial Subscription 			

$15.00
$100.00 (Includes 24 emailed newsletters)

Joint Members (2 members at the same address)
Joining Fee (once off)			
Biennial Subscription 			

$25.00
$130.00 (Includes 24 emailed newsletters)

Your subscription status is shown with your newsletter email, please check it each month
To Pay online

https://www.vicgum.asn.au/ and click on the VICGUM MEMBERSHIP link
												GUM
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